USER'S MANUAL

Version 1.7 Software

MERCURY
# TABLE OF CONTENTS

## Section 1 - Introduction

- What is CDS G3? ................................................................. 2
- CDS G3 Support................................................................. 2
- Installation............................................................................ 2
  - Administrative Rights .................................................. 2
  - Computer Requirements............................................... 2
- PC Minimum Hardware Specifications................................ 2
- Recommended Computer Specifications (Where Different from Above) ......................................................... 3
- Operating System Requirements...................................... 3

## Section 2 - Licensing and Registration

- License and License Key Explanations.................................. 6
- The CDS G3 License................................................................. 6
- License Activation................................................................. 6
- CDS G3 Version Number.............................................................. 8
- CDS G3 Updates........................................................................ 9

## Section 3 - Hardware

- Requirements........................................................................ 12
- SmartCraft Interface Cable...................................................... 13
- CDS G3 Harness Connections................................................... 13
- Vessels with a Junction Box...................................................... 13
- Vessels without a Junction Box............................................... 14

## Section 4 - New Features

- New Features Introduced in CDS G3 1.7.0............................. 16
  - Live Data View—Multiple Modules..................................... 16
- 5-Day Account Validation Extension........................................ 16

## Section 5 - Becoming Familiar with the CDS G3 Program

- Home Screen........................................................................ 20
- License Activation Screen....................................................... 20
- CAN Traffic............................................................................ 21
- Module Data Screen................................................................. 21
- Printing................................................................................... 22
- Live Data—Categories and Drag and Drop Sorting.................. 22
- Graphing.................................................................................. 22
- Gear Icon and More Options.................................................... 23
- eBOM..................................................................................... 24
- Configuration........................................................................... 25
- Personality............................................................................. 34
- Diagnostics............................................................................ 34
- Reflash.................................................................................... 39
- Show Options......................................................................... 41
- Literature............................................................................... 43

## Section 6 - Other Training Opportunities

- Mercury University ................................................................. 46
- E-Skill Courses....................................................................... 46
- Instructor-Led Training Courses............................................. 46

## Section 7 - Frequently Asked Questions

- FAQs..................................................................................... 48
Section 8 - Appendix

SmartCraft Interface Driver Installation.......................... 50  Error Codes............................................................. 50
Manual Driver Installation............................................. 50
Section 1 - Introduction

Table of Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is CDS G3?</td>
<td>2</td>
</tr>
<tr>
<td>CDS G3 Support</td>
<td>2</td>
</tr>
<tr>
<td>Installation</td>
<td>2</td>
</tr>
<tr>
<td>Administrative Rights</td>
<td>2</td>
</tr>
<tr>
<td>Computer Requirements</td>
<td>2</td>
</tr>
<tr>
<td>PC Minimum Hardware Specifications</td>
<td>2</td>
</tr>
<tr>
<td>Recommended Computer Specifications (Where Different from Above)</td>
<td>3</td>
</tr>
<tr>
<td>Operating System Requirements</td>
<td>3</td>
</tr>
</tbody>
</table>
What is CDS G3?

CDS G3 is a standalone PC-based program that complements the original Mercury Computer Diagnostic System (CDS) by providing diagnostic support for select engines and Mercury Joystick Piloting systems. Additionally, all configuration functions necessary for preparing these systems for delivery are supported. CDS G3 allows for CAN-based multiple-processor communication through a clean, easy-to-navigate interface.

CDS G3 Support

Mercury Marine will provide support for the CDS G3 program and hardware. Any issues determined to be outside of the CDS G3 program or hardware will be the responsibility of the user. For support with CDS G3, contact Mercury Marine Technical Service at 920-929-5884.

Installation

Any new installation of CDS G3 may be installed without a previous version of the software installed. Before proceeding with installation, complete all High Priority Updates as provided by Microsoft through Windows Update.

If updating CDS G3 from version 1.0, uninstall the software prior to installing the current version. If updating from CDS G3 version 1.1 or later, uninstallation is not required.

To install CDS G3, double-click the executable (.exe) that you downloaded from the service.mercurymarine.com website. During installation, the following programs may be installed:

- Microsoft® ReportViewer 2010
- Microsoft Visual C++ 2010 SP1 Redistributable Package (x86)
- Microsoft .NET Framework 4.5.2 Web
- Windows Installer 4.5
- Kvaser® 4.9 CAN Adapter Driver

These additional programs are required for CDS G3 to deliver a rich, interactive user experience.

When the Literature feature is installed, the following applications and libraries may also be installed:

- IIS Express 8.0
- Microsoft .NET Framework 4.5.1
- Microsoft Internet Explorer 11

Administrative Rights

The user performing the CDS G3 program installation must have administrative rights. If the computer has an MCDS user account, that user account was given administrative rights when it was created by an earlier CDS installation.

NOTE: Some information technology (IT) departments may restrict user rights for these accounts. If this has occurred, either the IT department must perform the installation, or they must grant administrative rights to the user accounts performing the installation.

Computer Requirements

The following specifications are established to support both CDS and CDS G3. Minimum and recommended specifications are listed below. Please adhere to the minimum specifications when upgrading CDS G3 on an existing computer. The recommended specifications have been established to provide a guideline for both best experiences and what we suggest when purchasing a new computer.

PC Minimum Hardware Specifications

- 1.2 GHz multi-core processor (two cores or more)
- 1024 x 768 screen resolution
- 10.1 in. screen size
- 2 GB RAM
- 120 GB hard drive
- 802.11 b/g/n wireless or 10/100 Ethernet
- DVD ROM optical drive (an external USB DVD drive is acceptable)
- Three USB 2.0 or 3.0 ports to accommodate CDS USB components. Alternatively, a single USB port and a USB port hub may be used.
- Optional 9-pin serial port (The serial port is no longer required, but is still preferred. The use for a serial port is for CDS only.)
Recommended Computer Specifications (Where Different from Above)

- Intel® i5 processor, 2.4 GHz or higher
- 8 GB RAM
- 128 GB solid-state drive
- 802.11n+ wireless connection

Operating System Requirements

Microsoft Windows® 7 Professional with Service Pack 1, Windows® 8.1 Professional, and Windows® 10 Pro are the only operating systems that have been tested to work with the CDS G3 product. For best performance, Windows® 10 Pro is strongly recommended. CDS G3 1.7 and greater versions will not support and will not operate on Windows® XP Professional or Windows® 8 Professional.
Table of Contents

License and License Key Explanations .................................. 6
   The CDS G3 License ...................................................... 6
License Activation .................................................................. 6

CDS G3 Version Number ..................................................... 8
CDS G3 Updates ................................................................... 9
License and License Key Explanations

**License:** A license enables a Microsoft Windows® PC (see Operating System Requirements for details) to operate the CDS G3 Software during the support period (typically two years from the release date). One license is required for each PC that needs to operate the CDS G3 product.

**License Key:** A license key is a 25-character alphanumeric key (for example X1X1X-X2X2X-X3X3X-X4X4X-X5X5X) that is used to unlock the CDS G3 application and that ties a PC to a license. One license key will be issued for each license that is purchased. The key is purchased from Mercury Marine and will be shipped to the dealer on the license key card:

![License Key Image]

**NOTE:** A CDS G3 license can be removed from a machine by pressing the "Deactivate Machine" button from the Help->About menu. This will free up a license and allow the license key to be reused on a new or different PC. This option is only available when a license is active.

The CDS G3 License

Mercury Marine is the provider of the CDS G3 license, which permits the purchaser to access diagnostic content, configuration tools, and features via the CDS G3 product for business use only. Licenses and license keys are **NOT** transferable. Hardware is not provided with the purchase of a license and must be purchased separately.

The CDS G3 licensing agreement is presented for review and acceptance during installation. This document can also be accessed after installation in the start menu. The location is: **Start->Mercury Marine->End User License Agreement.** Review this document for further details.

License Activation

Version 1.7 no longer offers the trial option to use the software before it's activated. When a CDS G3 license has been activated, account revalidation is still required every 45 days. CDS G3 may only be used by contracted Mercury Marine accounts, so the 45-day revalidation requirement is partially intended to ensure that only active accounts may use the software. The other purpose for revalidation is to ensure the software stays up to date. To license and validate CDS G3, internet access is required. The software installation may be revalidated at any time to restart the 45-day validation period. If the PC is connected to the internet when CDS G3 is started, revalidation will automatically occur. Manual revalidation can be done from the Help->About window by pressing the Validate Account button. Once the 45-day validation period has expired, the software will be disabled until revalidation is completed. If the 45-day validation expires in error, revalidation requirement may be extended for five (5) days to get the current job completed. However, by the end of the 5-day extension, account revalidation must occur before the software will work again.
When the CDS G3 software is started for the first time, the license activation screen will launch and will prompt the user for a dealer number and the 25-character license key that was purchased from Mercury Marine.

Enter the dealer number and license key. Click "Activate."

Once you click on "Activate," the following screens will appear:
CDS G3 Version Number

CDS G3 versions are defined by a version number. The example below shows version 1.7.0. The version number will define three parts of the version: a major version, a minor version, and a build number. The image below is from the CDS G3 startup splash screen, along with a description of the version number.
The complete version number can be noted from the splash screen, as shown above, or by selecting Help->About from the menu at the top of the screen. The following screen will display.

The major version number will designate drastic changes to the software.
This number has not changed since the introduction of the CDS G3 software. The minor version number designates considerable changes in the software, usually requiring the release a new executable. Typically this update will introduce new functionality and address major issues.
The build release number designates small changes in the software. Typically this includes new eBOM’s (electronic bill of material), minor bug fixes, and provide slight product improvements. These updates are downloaded from within the CDS G3 program.

CDS G3 Updates
Only build releases are provided at no charge during the active support period. Mercury Marine will make every effort possible to make each of these releases available directly through the CDS G3 application from the Home screen. As long as the computer has internet access when the CDS G3 software is started, it will automatically check for available updates. When updates are available, there will be a notification on the Home screen or on a pop-up at the bottom of the screen. The update process can also be manually initiated by selecting “Check for Updates” from the gear menu on the Home screen. In the event that updates cannot be provided directly from CDS G3, they will be made available through the service.mercurymarine.com website. When an executable (.exe) is provided as an update, it will contain everything needed to install and run the software. There is no need to have a previous version of the software installed. Also, if a previous version is installed, an executable update can be installed without uninstalling the previous version.
The CDS G3 kit no longer includes an installation disc; it will only contain the hardware required to use the software and a license key. If you don't have a high-speed internet connection available to download the executable in an acceptable amount of time, a backup disc which contains the latest installation of CDS G3 is available for purchase. The purchase of a backup disc does not include a license to use the software.
Notes:
Section 3 - Hardware

Table of Contents

<table>
<thead>
<tr>
<th>Requirements</th>
<th>12</th>
<th>Vessels with a Junction Box</th>
<th>13</th>
</tr>
</thead>
<tbody>
<tr>
<td>SmartCraft Interface Cable</td>
<td>13</td>
<td>Vessels without a Junction Box</td>
<td>14</td>
</tr>
<tr>
<td>CDS G3 Harness Connections</td>
<td>13</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Requirements

CDS G3 requires the following hardware:

898289T81—SmartCraft interface cable (USB to DB9) (contains 879365022)

898289T83—CAN P and H adapter (DB9 to 10-pin CAN) (contains 8M0044023)

This harness functions only as an adapter between a DB9 and SmartCraft CAN connector

a - CAN adapter cable
b - Connects to SmartCraft interface cable DB9
c - Connects to engine or J-box CAN connector

8M0046081—Harness adapter w/resistors (10-pin CAN to 10-pin CAN)

Required to replace a termination resistor when one is removed to gain access to the CAN bus

a - Engine connection (note the Engine tag)
b - Termination resistor end (note yellow tag)

All of the components above are included in the CDS G3 kit, part number 8M0114141. When interfacing the CDS G3 diagnostic tool to the CAN bus, proper termination must be maintained. If the CAN bus is being accessed by removing a termination resistor, the 8M0046081 adapter harness must be used. If the CAN bus is being accessed through an open J-box port, 8M0046081 will not be used. More details on proper connection are detailed in the section, CDS G3 Harness Connections.
SmartCraft Interface Cable

The SmartCraft interface cable is a diagnostic interface to provide the ability for CDS G3 to communicate on Mercury CAN bus networks. Some features of the SmartCraft interface cable are:

1. Ruggedized
2. 2 channel (CAN P/H)
3. USB-to-DB9 interface
4. Powered from the PC, not the engine

The SmartCraft interface cable has three LED lights: one green power LED and two orange CAN bus LEDs.

The power LED will illuminate solid green to indicate it is functioning correctly. This LED will flash if it has an issue. If this is encountered, most likely the device driver is not installed properly. Corrective action for this condition is documented in the Appendix.

When the SmartCraft interface is properly connected to both an engine and the diagnostic computer, there will be a solid orange LED on the appropriate BUS indicator on the interface (BUS 1 and/or BUS 2). This LED will flicker with communication. Any noncommunicating BUS channels will be indicated with an occasional illumination of the associated orange LED. Similarly, the CAN P/CAN H button in the CDS G3 software would be red or yellow to indicate no communication and green to indicate communication.

CDS G3 Harness Connections

Vessels with a Junction Box

1. Insert the SmartCraft Diagnostic Interface USB connector into a powered USB port.
2. Connect the SmartCraft Diagnostic Interface DB9 connector to the CAN P/CAN H adapter harness DB9 connector.
3. Connect the CAN P/CAN H adapter harness to the junction box to communicate with the power package.

**IMPORTANT:** Ensure that the correct termination resistor is installed on the CAN P bus. The CAN P bus must be properly terminated for the tool to communicate reliably. Improper termination will result in communication errors or complete loss of communication.

![Diagram of SmartCraft Interface Cable and Connections](image)

**Legend:**
- a - SmartCraft interface cable
- b - CAN P and H adapter
- c - Harness adapter with resistor
- d - Connect to engine or J-box connection
- e - Connect to key f of CAN P and H adapter
- f - Connects to e
- g - Connects to h
- h - Connects to g
- i - Connects to computer USB port
Vessels without a Junction Box

1. Insert the SmartCraft Diagnostic Interface USB connector into a powered USB port.
2. Connect the SmartCraft Diagnostic Interface DB9 connector to the CAN P/CAN H adapter harness DB9 connector.
3. Remove the CAN P termination resistor from the engine harness.
   IMPORTANT: Ensure that the correct termination resistor is installed on the CAN P bus. The CAN P bus must be properly terminated for the tool to communicate reliably. Improper termination will result in communication errors or complete loss of communication.
4. Connect the CDS G3 harness adapter (84-8M0046081) to the CAN P/CAN H adapter harness, and connect the adapter harness to the engine harness connector.

IMPORTANT: The CDS G3 harness adapter (84-8M0046081) contains the correct termination resistor for the SmartCraft Diagnostic Interface to communicate with the control module.
## Section 4 - New Features

### Table of Contents

<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Features Introduced in CDS G3 1.7.0</td>
<td>16</td>
</tr>
<tr>
<td>Live Data View—Multiple Modules</td>
<td>16</td>
</tr>
<tr>
<td>5-Day Account Validation Extension</td>
<td>16</td>
</tr>
</tbody>
</table>
New Features Introduced in CDS G3 1.7.0

With the release of CDS G3 1.7, Mercury Marine is excited to introduce two new features, multi-module support and account revalidation emergency extension.

Live Data View—Multiple Modules

The live data view—multiple module feature was developed to help in multiple engine applications when one engine is running abnormally and the other engines are running normally.

To use this feature, go to the Module Data screen and select the System Data button at the top. Then, select the desired modules or engines to compare.

5-Day Account Validation Extension

The 5-day account validation extension feature has been added to address those situations where CDS G3 users have forgotten to revalidate the software before the 45 day revalidation period has expired. Selecting the "Extend 5 Days" button will allow fully functional use of the CDS G3 without revalidation or connecting to the internet for five additional days. This feature will be especially useful for the technician that has traveled offsite to a customer's boat, only to discover upon arrival that the CDS G3 program needs revalidation. Instead of spending precious time searching for an internet connection, the technician can immediately get to work on the boat and perform the revalidation after returning to the shop.
CDS G3 1.7 has a big change because the entire licensing and revalidation process was rewritten, all of which benefit the dealer from a time perspective and help make customers happy more quickly. The 5 day extension is one important piece of the licensing change.
Section 5 - Becoming Familiar with the CDS G3 Program

Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home Screen</td>
<td>20</td>
</tr>
<tr>
<td>License Activation Screen</td>
<td>20</td>
</tr>
<tr>
<td>CAN Traffic</td>
<td>21</td>
</tr>
<tr>
<td>Module Data Screen</td>
<td>21</td>
</tr>
<tr>
<td>Printing</td>
<td>22</td>
</tr>
<tr>
<td>Live Data—Categories and Drag and Drop Sorting</td>
<td>22</td>
</tr>
<tr>
<td>Graphing</td>
<td>22</td>
</tr>
<tr>
<td>Gear Icon and More Options</td>
<td>23</td>
</tr>
<tr>
<td>eBOM</td>
<td>24</td>
</tr>
<tr>
<td>Configuration</td>
<td>25</td>
</tr>
<tr>
<td>Personality</td>
<td>34</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>34</td>
</tr>
<tr>
<td>Reflash</td>
<td>39</td>
</tr>
<tr>
<td>Show Options</td>
<td>41</td>
</tr>
<tr>
<td>Literature</td>
<td>43</td>
</tr>
</tbody>
</table>
Home Screen

The Home screen will report important information, including issues requiring attention. The screen capture to the right, is displaying notifications of a new software update, the SmartCraft interface cable is not detected, and no eBOM is selected. These issues should all be addressed for CDS G3 to function properly.

License Activation Screen

The License Activation screen will be presented on any CDS G3 installation that has not been activated. This screen is also displayed when the 45 day revalidation period expires. To activate a license, an internet connection is required. The full dealer number and the 25-character license activation key are required. Account revalidation is required every 45 days, but is performed automatically when an internet connection is present during the application startup. It can also be performed manually at any time. Once completed, the 45-day registration period is reset.
CAN Traffic

The CAN button will let you know the communication status on CAN P and CAN H.

- Red—The computer is not connected to the SmartCraft Diagnostic Interface cable
- Yellow—The computer is communicating with the cable but no data is being received on the CAN bus.
- Green—The computer is communicating on the CAN bus.

NOTE: CAN H will only turn green for models using CAN H. (Example: Outboard Joystick Piloting and Axius products)

Module Data Screen

The Module Data screen allows the user to view data and engine faults. The selections in Module Data include:

- **Play Data**: Allows the user to open a recorded file (.bdr) from a previously recorded session and play back the data in raw format.
- **Record Data**: Allows the user to choose data items and record them to a file (.bdr).

NOTE: Only numerical items may be recorded at this time; this may not represent all of the items available via live data.

- **Live Data**: Provides access to the data items for all modules.
- **System Data**: Provides the ability to view data at system levels, and to compare data between multiple modules in that system.
- **View Faults**: This button is only available if faults are found on the engine. The red text in the info column indicates that the engine has faults.
- **Freeze Frame**: Provides access to memory buffers within the ECM. Freeze Frame buffers contain snapshots of data items at the time a fault occurs.
- **Run History**: Provides access to a runtime history map. Each time value is assigned to an RPM band. The RPM bands can be cleared but the total engine runtime will stay the same.
- **Maintenance**: Displays the current maintenance value, and provides access to resetting the maintenance percentage to 100%.
- **Reload Modules**: Clears all modules in module data and restarts module discovery.
- **Clear All Module Faults**: Clears all faults present and rescans for faults.
Printing

A newer feature in CDS G3, introduced in version 1.5, is the ability to print data from **Freeze Frame**, **Faults**, and **Run History**. This feature provides the ability to create a clean, professional document in printed form, or a PDF document. Each of these screens will have a gear icon in the upper right corner to access the Print Page feature. This icon will not be available from View Faults or Freeze Frame if faults or freeze frame data are not present.

Another new print feature is the ability to create a full report. A full report will create a summary view, and include freeze frame, faults, and run history, along with the ability to include your full dealership information and your customer's information.

A full report can be created by selecting File->Print Full Report, or pressing F12. Inside the preview of a full report, a gear icon will be available to include or exclude dealer and customer information.

The customer's information can be added directly into this menu when Add Customer Information is selected. This information will be available until the CDS G3 program is closed; it will then be removed. You may change this information at any time without closing the software by selecting the gear icon, Remove Customer Information, and again select the gear icon and Add Customer Information. The Add Customer Information window will open and allow you to change the content.

Dealer information is downloaded from the Mercury Marine servers and is not currently editable.

With the inclusion of these new print features, the Print Screen button in the main tool bar has been removed. You can still use the old print screen function by either selecting File->Print Screen, or pressing Ctrl+F12 to capture the current screen.

Live Data—Categories and Drag and Drop Sorting

The live data screen has undergone considerable changes intended to improve readability and ease of use. Along with improvements to the layout, all data items may be reordered by simply dragging and dropping the item in the desired location. This will allow you to bring focus to items of concern within the same view without having to scroll to view data items. While working with some systems, the live data screen may now show two tabs. These tabs are categorized data list items: **Engine** and **Catalyst**. Data items specific to catalyst have been located in the catalyst category. When diagnosing a catalyst related issue, selecting the catalyst category will provide you with quick access to this data without having to filter through the full data list.

Graphing

The Graphing feature is integrated into the Live Data section inside Module Data. When in Live Data, graphing can be initiated by selecting up to eight items by simply clicking on the box to the left of the item. The chosen items will then turn green and display a check in the box. As each is selected, the graphing tab will display the quantity of items chosen. Next, select the Graph tab. This will open the graphing interface and start to plot and graph the items previously selected.

While using the graphing feature, there are several controls to enhance use. On the right side of each graph is a tab, which will expand that specific graph to a full screen view. While in this full screen view, the additional controls will be available.
The triangles to the right can be dragged up and down to define upper and lower limits. Also on the left are + and – buttons to zoom in and out. The focus point of zoom is the middle of the graph. It is best practice to pan the graph to the desired area before zooming. Above and below the zoom controls are up and down buttons to pan the chart. By selecting the shrink button in the lower right, the view will return to the previous screen, keeping the settings just made.

The gear icon in the graphing display will provide more shading options for the graph, along with logging customer information and resetting the graphs to their default settings. By providing customer information, any recordings can be saved with this information preentered as the file name. At any time, while in either Live Data or Graphing, recording data can be initiated by clicking on the record button in the lower left. After a recording is made and saved, all the data is available to be replayed either in a data view or graphing view for further analysis.

![Graphing screen example](image)

**Gear Icon and More Options**

As shown previously, there is now a gear icon on select screens. By clicking on this gear icon, more options for the specific feature will be shown.
Section 5 - Becoming Familiar with the CDS G3 Program

**eBOM**

The eBOM (electronic bill of materials) screen displays the possible matches to the system the tool is connected to. CDS G3 has the ability to actually talk to each ECM/PCM that is connected in the boat via CAN P. It will report what ECM/PCM it has found by showing a match next to those particular eBOMs. Some boats can have multiple ECM/PCM's depending on the SmartCraft configuration and the number of engines.

The eBOM Selection Helper has been implemented to assist the user when CDS G3 cannot resolve the selection of an eBOM.
Configuration

Configuration allows the user to access the helm-related configuration items, such as steering wheel, handles, and CAN pads.

**Helm Configuration** provides access to helm status and configuration tools required for the setup or repair of a DTS system. The items within this section are as follows:

- **Helm Setup** allows the user to configure a helm to make the control system fully operational. By following the helm setup wizard, the module ID is set as part of the process.
**Current Configuration:** This tab displays the current helm configuration status of the vessel. The information is presented in a matrix format that is configured in a manner that displays information relative to the back of a boat. Example: starboard on the right and port on the left. Some of the information provided in a matrix is the module's city ID, software version, and quantity of modules at that address.

**Assign City ID:** This tab allows the user to set the City ID’s for each helm module. This is exercised by moving a handle that coincides with a module. By following this wizard, the module’s City ID is set.

**Lever Adapt:** This tab allows the user to configure the lever through its range of operation so that the module can learn the positions of forward, neutral, reverse, and all detents.
Steering Wheel Config: This feature provides access to a tool that allows the user to set the center location of the steering wheel. The tool must see movement of the steering wheel for the value to be set. For example, if the steering wheel is already in the center position, move it left or right and back to center to set the value.

Remote Joystick Configuration: The Remote Joystick Configuration button provides access to a tool that allows the user to define the number of remote joysticks available on each helm. The number of helms will be displayed followed by the number of remote joysticks the helm can use and the number of joysticks that are enabled for the helm. This does not indicate a total number of joysticks on the vessel, but rather the number of joysticks accessible by each individual helm.

CAN Pad Configuration: CAN Pad Configuration provides access to Trackpad, Autopilot, and SMUX status and configuration tools required for setup or relocation within a SmartCraft system. The items within this section follow:
Trackpad Configuration: This feature allows the user to view and configure the trackpad on each helm. Trackpad Configuration displays the current trackpad configuration status of all helms, as well as information related to each trackpad. Trackpads that show in the grid with a black background are not configurable. If there is more than one trackpad at a single address, the trackpad in conflict will need to be reassigned to a new address. To identify a trackpad at a specific location with one in the grid, press a button on that trackpad and a cell in the grid will flash indicating its location.

IMPORTANT: To prevent potential conflicts with another module, this tool will not assign a trackpad to the address of D9.

Restore Defaults: This feature gives the option to assign all trackpads to their original City ID.

Autopilot Configuration: This displays the current autopilot pad configuration status of all helms, as well as information related to each autopilot. Autopilot pads that show in the grid with a black background are not configurable. If there is more than one autopilot at a single address, the autopilots in conflict will need to be reassigned to a new address. To identify an autopilot at a specific location with one in the grid, press a button on that autopilot and a cell in the grid will flash indicating its location.
**Assign Trackpads:** This feature provides the user a wizard for assigning autopilot pad addresses by helm. All configurable autopilot pads on a helm will flash.

*NOTE:* Autopilot pads on earlier Zeus and Axius models may not be configurable.

**SMUX Configuration:** SMUX Configuration allows the user to view and configure the SMUX on each helm. SMUX (smart multiplexing) refers to the rocker switches. The Configuration tab displays the current SMUX configuration status of all helms, as well as information related to each SMUX. SMUX that show in the grid with a black background are not configurable. If there is more than one SMUX at a single address, the SMUX in conflict will need to be reassigned to a new address. To identify a SMUX at a specific location with one in the grid, press a button on that SMUX and a cell in the grid will flash indicating its location. The Assign SMUX tab provides the user a wizard for assigning SMUX addresses by helm. All configurable SMUX on a helm will flash.

**Drive Configuration:** Drive Configuration provides access to a tool required for the setup or repair of a DTS system. The items within this section follow:
**Drive Initialization:** Drive Initialization provides access to a system feature that moves the drives and trim tabs throughout their range of operation to learn the sensor range values.

**Drive Alignment:** Drive Alignment provides access to a feature that performs an on the water and under power drive adjustments test needed to maintain a straight heading.

**Compass Configuration:** Compass Configuration provides access to any compass configuration settings required to setup or repair a Joystick Piloting vessel. The features within this section follow:
**Compass Calibration:** The Compass Calibration Wizard will walk you through all the steps necessary to configure and validate the compass for use by the autopilot systems. This is the recommended path for completing the compass configuration process.

**Compass Orientation:** The Compass Orientation step allows you to define how the IMU is physically mounted with respect to the bow of the vessel.

**Compass Linearization:** The Compass Linearization step will adjust the compass for your region’s magnetic deviation.
Clear Compass Compensation: The Clear Compass Compensation step clears the heading error compensation table that is created and used by the autopilot to arbitrate headings between the IMU and GPS.

Auto Heading Offset: Auto Heading Offset uses the GPS to automatically adjust the compass based on how well the compass is pointed towards the bow of the boat.

Manual Heading Offset: This feature allows you to manually enter a known heading by referencing another source (external to the boat) which will adjust for how accurate the compass is pointed towards the bow of the boat.
**Validate Compass Configuration**: The Validate Compass Configuration step validates your current compass to ensure it will work properly with the autopilot features.

**Merc TDS Reset**: The Merc TDS Reset configuration is used to pair key fobs to the Merc TDS (Theft Deterrent System) or remove the Merc TDS.
Personality

Personality (referred to as Import in previous versions of CDS G3) allows access to a function for importing a vessel specific file into a boat that contains calibrated parameters. (Example: boat length, center of gravity, or reverse drive efficiency.) This screen also provides the ability to import and export gauge settings. These files are created by an OEM engineer. This feature applies to a Joystick Piloting system.

Diagnostics

Diagnostics allows access to diagnostic functions that enable the user to perform operations like injector test, spark test, setting engine location, cylinder misfire test, etc. These tests are initiated by CDS G3, but are controlled by the ECM/PCM.
Set Trim Limit: This feature allows adjustment of the upper limit the drive can travel while under power. Because this is a configuration feature, and not a test, this procedure will eventually be moved to the Configuration section.

Set Tilt Limit: This feature allows the user to set the maximum tilt up location from an ERC. Set Tilt Limit is controlled through the ECM and is only active at low RPM and when the engine or drive receives a trim request from the ERC. Setting a lower value than factory default is useful if there is an obstruction that would cause damage to an engine, drive, or boat component while trimming. Because this is a configuration feature, and not a test, this procedure will eventually be moved to the Configuration section.

Set Engine Location: This feature allows the user to view or change the current engine location. Changing the engine location is necessary when setting up a multiengine boat. Because this is a configuration feature, and not a test, this procedure will eventually be moved to the Configuration section.
**Set Tach Link**: This feature allows the user to configure the signal coming from the gray engine harness tachometer lead. This drives either an Analog Gauge Interface (AGI) or an SC100 System Link gauge. When Tach Link is enabled the gray tachometer lead does not output the analog tach signal. Instead, the PCM sends a digital signal that can be received by the Analog Gauge Interface (AGI) or SC100 System Link gauges, if the proper adapter harnesses are connected. To turn the Tach Link function OFF, select Disable. The gray engine harness tach lead once again outputs an analog tach signal. Tach Link only appears as an Active Test menu option if the function is supported by the selected engine’s processor. Because this is a configuration feature, and not a test, this procedure will eventually be moved to the configuration section.

**Cylinder Misfire**: This test allows the user to isolate a problem for a particular cylinder. Select a cylinder and start the test to diagnose the engine; watch and listen for a reaction in the running of the engine to occur. No reaction would indicate a possible issue on that cylinder.  

**NOTE**: On FourStroke, large horsepower engines it may be difficult to detect any noticeable RPM or sound changes when the misfire test is done at idle. If no obvious change is noticed, try to test again at another throttle position greater than zero percent or under load.

**Fuel Pump Output**: This test allows the user to test the fuel pump for mechanical activity. The test will not function if the engine is running.
**Idle Air Control**: This feature allows the user to test the functionality of the idle air control valve. The behavior of this test on a running engine will depend on the engine coolant temperature and idle control calibration in the ECM. Once the engine has reached its normal operating temperature the running test will allow you to apply a positive or negative offset to the base IAC set point. As you decrease the offset with a negative value the engine RPM should decrease. The engine idle control strategies may prevent you from exceeding allowable set points.

**Horn Output**: This feature allows the user to test the horn. Listen for the horn to sound during this test.

**Ignition Spark**: This test confirms the existence and strength of the spark.
Smart Start: This feature allows the test of the Smart Start system and allows the user to start and stop the engine from the CDS G3 program.

Tach Output: Used to validate that an analog gauge is calibrated properly and the ECU is driving the analog signal.

Steering Override: This test is used on Axius engines only and allows you to override the TVM drive position on an Axius Gen I or Axius Gen II system. You can set the drive position via a slider or select auto to begin a sine wave sequence for a short period of time. For Axius Gen I, the engine must be running to change the drive position. Axius Gen II systems have the option to override the drive position while the engine is not running.
**Injector Pulse**: This test confirms if an injector is actuating while installed in the engine.

**Auto Test**: This selection performs a series of tests to identify if any faults are generated. This test also energizes the ignition system to generate a spark as a starting point for diagnostics.

**Reflash**

Reflash allows a user to reprogram control modules.

- **Module Reflash**: This feature will take you into a guided process for reprogramming modules.
- **History**: This will allow the user to view all previously performed reflash events.
Reflash Package Browser–Show All: The browser displays a list of available reflash upgrades. The page file consists of specific modules that are allowed to be upgraded. The page also gives the user a wide variety of methods to sort and search the list of package files (e.g. date, category, service bulletin, etc.). When Show All is selected you will be shown the other selectable status, Show Filtered.

Reflash Package Browser–Show Filtered: When Show Filtered is selected, you will only be presented with reflash packages available for detected modules.

Reflash Package Browser–No Updates: If the modules detected have no reflash packages available, a notification is presented stating this. This is only available in the filtered view.
Reflash Prerequisites: These indicates the requirements that must be met for reflash to proceed. If you receive green check marks the requirements have been met. A red X indicates the prerequisite has not been met. A yellow exclamation point identifies a caution status. For details on each prerequisite, see the dedicated page under reflash in the help menu.

Reflash Module View: This view will show you the modules available from the selected reflash package. If the module is upgradeable this will be indicated by a lightning bolt icon. The topmost upgradeable module will be highlighted indicating the order in which to reflash. Up-to-date modules will be indicated by a green check icon. Modules that are in the package but that may have a wrong calibration ID, or missing information, will be indicated by a slashed circle icon. Modules that are conflicted (for example, more than one module on the same city ID) will be indicated by a red icon.

NOTE: Multiple engine/helm configurations may require a certain engine to be keyed off.

Reflash–Serial Number/Hull ID: This allows the user to input the information into CDS G3 for record keeping.

Reflash Cautions: This page warns you to be careful when reflashing. It is important to make sure you disconnect all SmartCraft gauges, including VesselView, prior to reflash.

Reflash Progress: This page allows the user to monitor the progress of the reflash event. After a successful reflash, helm adaptation or set engine location may be required as determined by the package file. Perform the required steps and click close to be redirected to finalize the reflash session.

Show Options

These settings are accessed from the upper text menu by choosing Options.

Show Options allows you to setup or change certain behaviors of the software. For instance, you could change the save location of the Print Screen function.

CAN Hardware Settings: This menu allows the user to configure the SmartCraft Diagnostic Interface.
Data Record: The Data Record settings allow you to change the location the application will place a recorded file and the CSV export file.

Reflash History Directory: This menu allows you to view and change the reflash history output directory where reflash reports will be saved.

Screenshots: This menu allows you to configure the print screen settings by changing its location.

Units: This function was released with version 1.4 software. It allows the user to change the units of measure on the live data screen. You can choose from English, metric, or custom, which allows you to customize your units of measure for each of the following: temperature, speed, volume, flow rate, and pressure.

Connections: This menu allows the user to enter proxy settings that may be required in order to access the internet in a managed network.

NOTE: For most dealerships proxy settings will not be used. Only enter information your network administrator provides. Entering incorrect information will prevent registration and updates from functioning.
**Language:** This screen allows the selection of foreign languages. It also allows you to set the Data List descriptions from standard to engineering terms.

**Help Screen:** The Help feature has been removed and the contents are now integrated into the user’s manual. The user’s manual is available in the Windows Start Menu, in the folder named *Mercury Marine*. The User’s Manual can also be accessed through the new literature feature. More information is available under the literature feature in this document.

**Literature**

To open literature, select the literature icon on the bottom right of the CDS G3 program, and a new interface will be launched.

When inside of the service literature feature, various service manuals will be selectable for use. Version 1.7 will have more literature available as the service literature is updated to be compatible with this new platform.

When new literature becomes available, it will be displayed as available for download from the Library. In a later release of 1.7, service bulletins will also be provided and available through the Library.

Additional functions inside the literature feature include:

1. Create bookmarks to frequently used sections
2. Create your own mark ups, edits, and notes
3. Search within the service manual
## Section 6 - Other Training Opportunities

### Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mercury University</td>
<td>46</td>
</tr>
<tr>
<td>E-Skill Courses:</td>
<td>46</td>
</tr>
<tr>
<td>Instructor-Led Training Courses:</td>
<td>46</td>
</tr>
</tbody>
</table>
Mercury University

Mercury University provides comprehensive E-Skills and Instructor-led training with CDS G3.

E-Skill Courses:
- CDS G3 Software, Menus and Navigation
- CDS G3 Covering 40–60 HP EFI FourStroke
- MerCruiser Catalyst Troubleshooting

Instructor-Led Training Courses:
- Intro to CDS
- FourStroke
- FourStroke Advanced Troubleshooting
- Catalyst Advanced Troubleshooting

Sign up for courses at www.mercuryuniversity.com.
Section 7 - Frequently Asked Questions

Table of Contents

FAQs.............................................................................................................. 48
FAQs

Q: I am entering my dealer number and license key correctly to register but I receive an error stating "Invalid Dealer."
A: CDS G3 requires your full dealer number and license key. Verify you are entering these correctly.

Q: Is CDS G3 Windows 7 compatible?
A: Yes, since version 1.2. Compatibility is limited to Windows 7 Service Pack 1 Professional, Ultimate, or Enterprise. Windows has other versions, most commonly Windows 7 Home Premium, which is not compatible with CDS G3. You may be able to update noncompatible versions of Windows 7. Refer to Microsoft Windows Anytime Upgrade for details. http://windows.microsoft.com/en-US/windows/shop/windows-anytime-upgrade

Q: Is CDS G3 compatible with Windows 8.1 Professional?
A: CDS G3 version 1.5 and newer is compatible with Windows 8.1 Professional.

Q: Is CDS G3 compatible with Windows 10 Pro?
A: CDS G3 version 1.7 and newer is compatible with Windows 10 Pro.

Q: Is CDS G3 compatible with 64-bit operating systems?
A: Yes, version 1.2 was compatible but contained a bug which prevented the software from updating. This issue was corrected in version 1.4. All versions from 1.4 forward are fully compatible with 64-bit operating systems.

Q: Will CDS G3 work with Verado?
A: At this time, CDS G3 will work with Joystick Piloting for Outboards, including Verado. Older versions of Verado require CDS.

Q: What should I put in the proxy settings in options/connections?
Do not put anything in these fields unless specified by your network administrator. In most cases, a proxy is not used. If these fields are filled in incorrectly, communication to Mercury Marine servers for registration and updates will fail.
# Section 8 - Appendix

## Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>SmartCraft Interface Driver Installation</td>
<td>50</td>
</tr>
<tr>
<td>Manual Driver Installation</td>
<td>50</td>
</tr>
<tr>
<td>Error Codes</td>
<td>50</td>
</tr>
</tbody>
</table>
SmartCraft Interface Driver Installation

In versions prior to 1.4, we have noticed a high number of issues with the SmartCraft interface cable not working after a new installation. In version 1.4, we have addressed several issues to improve this process. If you experience a suspected driver issue, the key indicator is the green power LED on the SmartCraft interface cable is flashing. This likely means the driver is not associating with the hardware. Reference the following manual driver installation instructions. If the LED is a solid color, reboot your PC and try again.

Manual Driver Installation

To begin, make sure your SmartCraft interface is unplugged and CDS G3 is closed. Plug in the SmartCraft interface and watch the lower right corner for a *new hardware found* notification. Click on this notification to open the **New Hardware Wizard**. When asked if Windows can connect to Windows Update, select **No, not at this time**. The driver was already installed with CDS G3. On the next screen, select **Install the Software Automatically**. When finished, confirm the green power LED on the SmartCraft interface is no longer flashing. A reboot may be required. Repeat this process for each USB port on your PC.

Error Codes

Please go to [service.mercurymarine.com/g3/support/g3-error-codes](service.mercurymarine.com/g3/support/g3-error-codes) to see the latest list of error codes that may be displayed in CDS G3.